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Welcome to DiskTracker! 
 
 
Thank you for using DiskTracker, the complete disk cataloging and labeling system for the 
Macintosh.  This application has been in development for quite some time now and it is our 
intention to make it the best program of its type available.  If you have any suggestions for or 
questions about DiskTracker, please don’t hesitate to contact us at support@portents.com. 
 
Also, be sure to visit the DiskTracker World Wide Web page at: 
http://www.disktracker.com/ 
for DiskTracker news, support files, and information about new releases. 
 
 
 
 
 

Introduction 
 
 
What is DiskTracker? 
DiskTracker is a multipurpose application dedicated to a single task: keeping track of the 
contents of your disk volumes, be they hard disks, CD-ROM's, file servers, or removable media. 
Classically such applications have been dubbed “disk catalogers”.  DiskTracker’s usefulness goes 
far beyond simply cataloging disks, though. 
 
DiskTracker allows you to view the contents of your cataloged disks in an intuitive, Mac OS 
Finder style “view by list” window.  In addition, the application has the ability to print custom 
disk labels, templates for which can be designed in an advanced “object-oriented” MacDraw™-
like environment.  DiskTracker can quickly locate files which match any combination of over 
twenty separate criteria with a flexible multi-criteria “Boolean” search system and can even 
locate duplicate files across multiple disks and within StuffIt™ and Compact Pro™ archives.  All 
of these features, plus many more, are packaged together in a fast, intuitive environment that is 
fun to use. 
 
 
 
 
 
Why use DiskTracker? 
DiskTracker offers the ability to have, in a single compact file, a record of the contents of all of 
your disks.  This includes hard drives, removable media, CD-ROMs, and even those floppy disks 
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which are gathering dust in the back of some disk box.  This makes finding lost files really easy.  
Never again ask “Where the heck did I put that file?” - with DiskTracker, you need only open the 
catalog file, and the file’s location is just a search away. 
 
DiskTracker can access its catalog data far faster than the MacOS can read directory 
information off a floppy, file server, or CD-ROM.  This makes browsing lightning quick and 
searching even faster.  And, because the application’s environment resembles the Finder so 
much, you won’t be left with the question - “How the heck do I use this program?”  Add to that 
DiskTracker’s built-in virtual memory scheme, which allows even the largest volumes to be 
scanned in a minimum memory partition (and still be able to be accessed quickly), and you have 
a truly indispensable file management tool. 
 
DiskTracker can even produce gorgeous disk labels.  This helps to avoid the third inevitable 
question encountered when dealing with software libraries - “What the heck is on this disk?”  
Although it is possible to simply put a little sticky-label on the disk and write down the contents 
on that, this is too much trouble for many of us, as, once we do label a disk, we forget to re-
label it later.  This leaves us with piles of disks labeled “Important files and such” that actually 
contain a bunch of useless old Hypercard games.  DiskTracker keeps track of whether the 
contents of a disk have been updated since the last time the disk was labeled.  Just one menu 
command and the program will show all of your disk labels in need of update! 
 
There are many other ways in which you will find DiskTracker indispensable - for some other 
great ideas, check out the DiskTracker web page! 
 
 
 
 
What is shareware? 
Shareware is a software distribution system under which you are free to try out a piece of 
software without obligation for a period of time (usually on the order of 30 days or so) for 
evaluation purposes.  If you decide that you would like to continue using the software, you are 
required to send a small fee (in the case of DiskTracker 2, $30) to the author for the continued 
usage of the program, or else delete the software from your system.  If you choose to register, 
the authors will, in return, give you notice of any future updates and provide low-cost/free 
upgrades when requested.  And, they’ll give you their eternal gratitude.  Really! 
 
You may (and we certainly encourage it) freely distribute UNREGISTERED copies of DiskTracker 
to friends and associates, as well as upload it to bulletin board/on-line services and internet FTP 
sites.  If you choose to pass around copies of DiskTracker, be sure you include all of the 
documentation and support files which were originally included with the program.  We would 
certainly prefer that you distribute the DiskTracker Installer as it appears on the DiskTracker 
web site, however - it's just simpler that way! 
 
Please get our permission before distributing DiskTracker on CD-ROMs or on other 
collections by sending emai l to support@portents.com. 
 
Note that we have not disabled features in unregistered copies of DiskTracker.  We feel that it is 
important, as it allows you to get more acquainted with all of a program’s features, and it builds 
a trusting relationship between you (the user) and us (the software developers).  However, IN 
NO WAY, does this free you from your obligation to register the software.  So send off those 
checks! 
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Support the shareware system!  
Register DiskTracker! 
 
 
 
Portions of this software are copyright © 1990-96 Aladdin Systems, Inc. 
 
graphic work by Quartz, 
<quartz@sneakertech.com>, 
<http://www.sneakertech.com/> 
 
StuffIt 5 file format courtesy of Norbert M. Doerner, author of CDFinder. 
http://www.cdfinder.de 
 
The installer for this product was created using Installer VISE from MindVision Software. For 
more information on Installer VISE, contact:  
 
                      MindVision Software  
                      7201 North 7th Street  
                      Lincoln, NE 68521-8913  
 
                      Voice: (402) 477-3269  
                      Fax: (402) 477-1395  
                      E-mail: mindvision@mindvision.com  
                      http://www.mindvision.com  
 
Special thanks goes out to the DiskTracker beta squad, those who have morally supported the 
DiskTracker endeavor, and particularly those users who have registered DiskTracker. 
 
DiskTracker™ is copyright © 1995-2003 by Mark N. Pirri and Portents, LLC  All rights reserved 
worldwide. 
 
Disclaimer of warrantee: 
THIS PROGRAM IS PROVIDED “AS IS”  WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED.  SHOULD THE PROGRAM BE FOUND TO BE DEFECTIVE, IN NO EVENT WILL THE 
PROGRAMMER BE LIABLE FOR ANY DAMAGES WHATSOEVER RESULTING TO PERSON OR 
EQUIPMENT. 
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Installation 
 
What do I need? 
Before installing and running DiskTracker 2, be sure that the following minimum system 
requirements are met: 
 

• Macintosh computer with a 68020 or greater microprocessor.  This does not 
include the Mac 128K, 512K/KE, Plus, SE, Portable, or PowerBook 100.  Users 
of these machines can still use DiskTracker 1.x.  DiskTracker is a fat binary, so 
it runs on 680x0 Macs and in native mode on Power Macintosh computers for 
maximum performance and compatibility. 

 
• Minimum System Requirements: System (Mac OS) 7.5.3 with CarbonLib 1.3 or 

Mac OS X 10.0.3. 
 
• At least 1.5 megabytes of available memory.  DiskTracker is able to run in as 

little as 1.5 megabytes of memory (utilizing a built-in virtual memory system), 
but the default partition size is set to 4.0 megabyte to ensure optimum 
performance. 

 
• Optional: StuffIt Engine version 5.1 or later.  This is necessary for copying 

items out of and into StuffIt archives. 
 
 
 
 
What’s in the DiskTracker package? 
The following items are included in the DiskTracker 2 package.  If any items are missing, it likely 
means that the DiskTracker package has been tampered with.  Please visit the DiskTracker web 
site to acquire a new, fresh version. 
 

• DiskTracker 2 application 
 
• DiskTracker Extension - the installer will place this in the Extensions folder 

of your System Folder 
 
• DiskTracker user manual - this file 
 
• Read Me First! - other information that, for some reason wasn't or couldn't 

be included in this manual 
 
• Item Filters folder - this folder contains several item filters 
 
• Label Sheet Layouts folder - this folder contains several label sheet 

layouts 
 
• Label Templates folder - this folder contains a number of label templates 

for different types of media 
 
• DiskTracker registration - this folder contains the Register DiskTracker 

application and the Registration Read Me 
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Please make sure that all of these items are present before you upload unregistered copies of 
the program to online services or internet FTP sites.  We would be most grateful, however, if 
you would simply distribute the DiskTracker Installer, as you might download it from the 
DiskTracker web site. 
 
 
 
 
Installing DiskTracker 
Installing DiskTracker 2 is simple – simply copy the software to your hard drive. 
 
On Mac OS X, copy the “DiskTracker” folder from the source disk image to the Applications 
folder (or whichever other install location is desired). 
 
On Classic Mac OS, copy the “DiskTracker” folder from the source folder to the Applications 
folder (or whichever other install location is desired).  If use of the DiskTracker Extension is 
desired, copy the “DiskTracker Extension” icon into the Extension folder of the System Folder. 
 
 
 
 
Running DiskTracker 
 

   
 Classic Mac OS Mac OS X 
 
To run DiskTracker, simply double click on the program icon.  Shortly thereafter, the program 
will present an empty catalog window into which disks can be scanned. 
 
 
 
 
Registering DiskTracker 
For instructions on how to register DiskTracker, please see the Registration read me file in the 
“Register DiskTracker” folder.  Please support shareware and register DiskTracker! 
 
 
 
 
Some important terms 
Before using DiskTracker, there are some terms that need to be defined: 
 

• Disk Catalog - An “image” of the directory structure of a disk (hard drive, 
CD-ROM, file server, removable media disk, etc).  Disk catalogs are the primary 
focus of DiskTracker, which creates, searches, and manages disk catalogs. 

 
• Catalog File - A file which contains disk catalogs of one or more disks. 
 
• Disk List - The collection of disk catalogs contained in a catalog file. 
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• Scanning a Disk - The process by which a disk (or volume) is examined and a 
disk catalog is created from its file structure. 

 
• Updating a Disk - The process by which an existing disk catalog is updated 

when the contents of a disk are changed. 
 
• Item - Generally refers to either a file, a folder, or a volume. 
 
• Item Class - An item’s type (i.e., file, folder, or volume).  Not to be confused 

with a file type (the four character code that identifies a file’s kind).  
 
• Item Filter - A collection of criteria which describe an item.  Item filters, 

often used in searches, can contain Boolean operations and grouped criteria. 
 
• Label Template - Defines how a label will look when it is printed.  Label 

templates can contain both static text items (do not change from label to 
label) and disk information fields, which show information about the disk (such 
as name, size, kind, etc). 

 
• Label Sheet Layout - Defines the characteristics for the type of sheet that 

DiskTracker is printing disk labels onto.  Contains such information as the 
number of labels per page, the margins, the label size, and the spacing 
between labels. 

 
 
 
 
About this manual 
Because of the number of features in DiskTracker that must be documented and the fact that 
we would like to keep the entire DiskTracker package fairly reasonably sized, this manual, while 
demonstrating each feature of the program step by step, assumes some familiarity with using a 
Macintosh. 
 
The DiskTracker manual is available in several different formats.  The copy of the manual that 
comes with the DiskTracker distribution archive is either in self-reading eDoc 2.1.1 format 
(Classic Mac OS) or PDF (Mac OS X).  The manual is also available in either PDF or Microsoft 
Word 5.x format from the DiskTracker World Wide Web page (http://www.disktracker.com/).  
Other than the file format, all of these manuals are identical. 
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CHAPTER ONE: Scanning and updating disks 
 
When DiskTracker scans a disk, it creates a catalog for that volume.  That is, it records the full 
directory structure (but not the contents!) of the disk and various pieces of information about 
the individual files and folders (including, among others, the creation date, modification date, 
size, and type/creator codes).  The process of scanning a disk can take anywhere from less than 
a second for a floppy disk to around a minute for a substantial hard disk to several minutes for a 
CD-ROM or file server.  Once a disk is scanned, the items on the disk can quickly be browsed, 
launched, or searched.  
 
Once a disk is scanned into a catalog file, it is useful to update its catalog occasionally as the 
contents of the disk change.  DiskTracker makes this simple by integrating the disk updater into 
the disk scanner. 
 
DiskTracker allows several methods of disk scanning and updating: 
 

• Batch Scan Disks 
• Scan Mounted Volumes 
• Drag and Drop Scan 
• Update Volume Catalog 
• DiskTracker Application Auto-Scanner 
• The DiskTracker Extension (more on this in chapter nine of this manual) 

 
 
 
 
Batch scanning disks 
When a batch scan is started, DiskTracker prompts for the insertion of a disk to be scanned.  
The disk may be any form of removable media (Zip, floppy, CD-ROM, etc).  As soon as a disk is 
inserted, a catalog is created from its contents and is then added to the current disk list.  If the 
disk has more than one partition (“session”), all of the partitions will be scanned.  After the disk 
is scanned, it is ejected.  Others may be inserted to be added to the list. 
 
If the disk inserted is already in the catalog, its contents will be updated as necessary. 
 
• Batch scanning disks: 
 

1.) Select “Batch Scan Disks…” from the Scan menu (or hit � B).  DiskTracker 
will prompt for a disk to be inserted. 

 
2.) Insert a disk into a disk drive. 
 
3a.) If an up-to-date catalog for this disk is already in the disk list of the front most 

window, DiskTracker will announce this.  No scanning or updating is necessary 
and the disk will be ejected. 

 
3b.) If the disk is already in the catalog file but its catalog is not current, 

DiskTracker will ask permission to update the disk’s catalog.  If instructed, the 
application will update the catalog.  Afterwards, the disk will be ejected. 

 
3c.) If there is no catalog for the disk, the disk will be scanned into the current disk 

list and is ejected when the scan is complete. 
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4.) Repeat step (2) for all additional disks to be scanned or updated. 
 
5.) Click “Done” when finished. 

 
 

TIP - By default, the “Faster Batch Scanning” option is enabled in the 
DiskTracker “General Preferences…” dialog.  This option provides a much 
faster batch scanning mechanism.  In turn, setting this option does not allow a 
scan to be canceled once it has been started and does allow switching into the 
background during the scan.  To disable fast batch scanning, see the section 
describing the “General  Preferences…” dialog box. 

 
 
 
 
Scanning mounted volumes 
 
• Scanning mounted volumes: 
 

1.) Select “Scan Mounted Volume…” from the Scan menu (� M).  A dialog with 
a list of all mounted volumes will appear. 

 
2.) Select the volumes to be scanned.  Command-click to select more than one, 

shift-click to select a range, or use the arrow keys.  Use the “Eject” button to 
remove mounted removable media disks from their drives. 

 
3.) Click the “Scan” button or hit the return key.  Clicking “Cancel” will exit the 

dialog without doing any scanning or updating. 
 
4a.) If an up-to-date catalog for a selected disk already exists in the current disk 

list, DiskTracker will announce this and no scanning or updating will occur. 
 
4b.) If there is a non-current catalog for a selected disk, DiskTracker will ask for 

permission to update the catalog. 
 
4c.) If there is no catalog for a selected disk, the disk will be scanned into the 

current disk list. 
 
 
 
 
Drag and Drop scan 
The Drag and Drop scanner allows disk icons to be dragged directly into a DiskTracker catalog 
window.  The disk will be scanned into that window. 
 
• Scanning disks by dragging them to a catalog window: 
 

1.) Drag the icons of one or more disks to be scanned from the Finder onto a 
DiskTracker catalog window. 

 
2a.) If an up-to-date catalog for a disk already exists in the catalog window’s disk 

list, the application will announce this and the disk will not be scanned. 
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2b.) If a non-current catalog exists for a disk, DiskTracker will ask to update the 
catalog. 

 
2c.) If there is no catalog for a disk, the disk will be scanned into catalog window’s 

disk list. 
 
 
An alternative way to use the Drag and Drop scanner is to drag a disk’s icon to 
DiskTracker’s icon.  This will scan the disk into the front most window.  If there is no 
front most window, or the front most window is not a catalog window, a new catalog 
window will be created. 
 
• Scanning disks by dropping them on DiskTracker’s icon: 
 

1.) Make sure that the Finder is the frontmost application. 
 
2.) Drag the icon of a disk to be scanned to DiskTracker's icon. 
 
3.) If no front most window is open, or the front most window is not a catalog 

window, a new catalog window will be created. 
 
4a.) If an up-to-date catalog for a disk already exists in the front most catalog 

window’s disk list, DiskTracker will announce this and the disk will not be 
scanned. 

 
4b.) If a non-current catalog exists for a disk, DiskTracker will ask permission to 

update the catalog. 
 
4c.) If there is no catalog for a disk, the disk will be scanned into the catalog 

window’s disk list. 
 
 
 
 
Update Volume Catalog 
The “Update Volume Catalog” command in the Scan menu allows a disk’s catalog to be quickly 
updated from the catalog window. 
 
• Updating volume catalogs: 
 

1.) Select a volume in the disk list of a catalog window.  See chapter two for more 
information on selecting items. 

 
2.) Select “Update Volume Catalog” from the Scan menu. 
 
3.) DiskTracker will prompt for the insertion of the disk, if it is not already 

mounted.  See chapter two for more information on the disk locator dialog 
box. 

 
4a.) If the catalog for the disk is up-to-date, the application will announce this and 

the disk will not be updated. 
 
4b.) If a non-current catalog exists for a disk, DiskTracker will update the disk 

catalog. 
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DiskTracker application auto-scanner 
When the DiskTracker application auto-scanner is enabled, there is no need to specifically tell 
DiskTracker when it is time to scan disks.  Instead, if the automatic options are set and a 
catalog file window is front most in DiskTracker, any disks that are inserted or mounted will 
automatically be scanned into that catalog file. 
 

NOTE - This is not the same as the DiskTracker Extension, which performs a similar 
function.  The Application Auto Scanner only functions when the DiskTracker 
application is running, and will scan disks as they are inserted.   The 
DiskTracker Extension will scan disks as they are ejected or unmounted and 
does not require DiskTracker to be running.  See chapter nine for more 
information on the DiskTracker Extension. 

 
• Enabling the application auto-scanner: 
 

1.) Select “Application Auto-Scanner…” from the “Preferences” submenu of 
the Edit menu.  DiskTracker will present the “Application Auto-Scanner 
Preferences” dialog box. 

 
2.) Click the checkboxes to set the automatic disk scanning and updating behavior 

while DiskTracker is running. 
 
3a.) If “When DiskTracker is in the foreground: Scan new disks” is 

checked, disks will be scanned into the front most window.  This will only 
happen when DiskTracker is the front most application and the disk does not 
currently have a catalog in the disk catalog list of that window. 

 
3b.) If “When DiskTracker is in the foreground: Update existing catalogs” 

is checked, disks in the front most window will be updated as they are 
inserted.  This will only happen when DiskTracker is in the foreground and a 
non-current catalog is contained in the disk list of that window. 

 
3c.) If “When DiskTracker is in the background: Scan new disks” is 

checked, disks will be scanned into the front most DiskTracker window.  This 
will only happen when DiskTracker is in the background and the disk does not 
currently have a catalog in the disk catalog list of that window. 

 
3d.) If “When DiskTracker is in the background: Update existing 

catalogs” is checked, disks in the front most DiskTracker window will be 
updated as they are inserted.  This will only happen when DiskTracker is in the 
background and a non-current catalog for the disk is contained in the disk list 
for that window. 

 
4.) Click the “OK” button to commit the new settings or the “Cancel” button to 

abort. 
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About ID files 
By default, DiskTracker identifies a specific disk by a combination of its name and its creation 
date.  If a disk is found with an identical name or creation date as another, DiskTracker will ask 
to verify that it is indeed the same disk. 
 
Each disk scanned is assigned a unique serial number to help identify the disk. 
 
In the event that DiskTracker is confusing disks, perhaps because of a number of identically-
named  disks (“Untitled”, for instance) or a number of disks with identical creation dates 
(preformatted disks often have the same creation date), DiskTracker can be instructed to 
create ID files.  An ID file is a tiny invisible file created on a disk containing information that 
allows DiskTracker to positively identify the  disk using its serial number. 
 
To enable ID files, disabled by default, uncheck the “Don’t create ID f iles” checkbox in the 
“Disk Scanner…” dialog box, found in the “Preferences…” submenu of the Edit menu. 
 
 
 
 
Removing ID files from disks 
DiskTracker provides a facility for easily removing ID files from disks. 
 

NOTE - If a disk appears in more than one catalog file, the identification information 
for both of those files is stored in the same ID file.  Stripping this file will 
remove the ID’s for both catalog files.  This could cause identification 
problems for one or more of those catalog files.  

 
ID files may be either batch-stripped from disks or from mounted volumes. 
 
• Batch stripping ID files from disks: 
 

1.) Select “Batch Strip ID Files From Disks…” from the Scan menu.  
DiskTracker will prompt for a disk to be inserted. 

 
2.) Insert a disk into a disk drive.   
 
3.) If the disk contains a DiskTracker ID file, the file will be removed.  If not, 

nothing will be changed.  In either case, the disk will be ejected when the 
operation is complete. 

 
4.) Repeat step (2) for any additional disks. 
 
5.) Click “Done” when finished. 

 
 
• Stripping ID files from mounted volumes: 
 

1.) Select “Strip ID File From Mounted Volume…” from the Scan menu.  A 
dialog with a list containing all of the on-line volumes will appear. 
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2.) Select the volumes to be stripped of their ID files.  Command-click to select 
more than one or shift-click to select a range.  Use the eject button to remove 
mounted removable-media volumes from their drives. 

 
3.) Click the “Str ip” button or hit the return key.  Clicking “Cancel” will exit the 

dialog without making any changes. 
 
4.) For each selected disk, if an ID file is found on that disk, it will be stripped 

away.  If not, nothing will be changed on the disk. 
 
 
 
 
Locating disks in a disk list 
Often, when a disk list contains a large number of catalogs, it can become difficult to match a 
physical disk to its catalog in the list.  To make this easier, DiskTracker offers the ability to 
examine a physical disk and show the corresponding disk in the disk list. 
 
Just like scanning a disk or removing an ID file from a disk, there are two methods for specifying 
which physical disk to locate: either locating disks or locating mounted volumes. 
 
• Locating disks: 
 

1.) Select “Locate Disk in Catalog…” from the Scan menu.  DiskTracker will 
prompt for a disk to be inserted. 

 
2.) Insert a removable media disk.  If DiskTracker can find the disk in the current 

disk list, it will select it and show it in the catalog window.  The disk will be 
ejected.  To abort, click the “Cancel” button. 

 
 
• Locating mounted volume: 
 

1.) Select “Locate Mounted Volume in Catalog…” from the Scan menu.  A 
dialog with a list containing all of the on-line volumes will appear. 

 
2.) Select on the volumes to be located.  Command-click to select more than one, 

shift-click to select a range, or use the arrow keys.  Use the eject button to 
remove mounted removable media volumes from their drives. 

 
3.) Click the “Locate” button or hit the return key.  Clicking “Cancel” will exit 

the dialog. 
 
4.) For each selected disk, DiskTracker will try to locate the disk in the current 

disk list.  If DiskTracker can find it, it will select the disk and show it in the 
catalog window. 

 
 
 
 
Setting the first disk serial number assigned 
It is possible to change the first serial number assigned by DiskTracker.  This ability is useful in 
order to avoid duplicate disk serial numbers across multiple catalog files. 
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• Setting the first disk serial number assigned 
 

1.) Choose “Assign Serial  Numbers From…” from the Scan menu. 
 
2.) Enter the value of the first disk serial number to be assigned. 
 
3.) Click “OK” to set the new value.  “Cancel” leaves the value unchanged.   

 
 
 
 
Customizing the disk scanner 
DiskTracker’s disk scanner offers several customizations, accessed through the “Disk 
Scanner…” dialog box under the “Preferences” submenu of the Edit menu. 
 
 
“Scan:” - Checkboxes under this subheading control which special-case items will be scanned 
when DiskTracker scans or updates a disk. 
 
These include: 
 

“Aliases” - Determines whether alias files should be scanned (on by default) 
 
“Desktop database files” - Determines whether the special “Desktop”, “Desktop 

DB”, and “Desktop DF” files should be scanned.  (off by default) 
 
“Items on desktop” - Determines whether items appearing on the desktop should 

be scanned.  If this box is checked, items on the desktop will be placed in a 
folder called “Desktop folder” at the root level of the disk catalog.  (on by 
default) 

 
“Items in trash” - Determines whether items which have been dragged to the 

trash (but not permanently erased by emptying the trash) should be scanned.  
If this box is checked, the items in the trash will be placed in a folder called 
“Trash” at the root level of the disk catalog.  (off by default) 

 
“Invisible items” - Determines whether items which are invisible (i.e., not shown in 

the Finder) should be scanned.  (on by default) 
 
“Make initia lly hidden” - Determines whether invisible items should be hidden in 

the DiskTracker catalog.  Hidden items are described in the next chapter.  (on 
by default) 

 
“Icon mosaics” - Determines whether those files or folders which make up icon 

mosaics should be scanned.  Icon mosaics are frequently used to create 
“pictures” that appear in disk’s window in the Finder.  (off by default)  

 
 
“Alert before updating catalogs” - This checkbox (on by default) configures DiskTracker to 
ask whether a disk should be updated.  This option has no effect on the application auto 
scanner or the DiskTracker Extension, neither of which ever asks for confirmation for disk 
updates. 
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“Don’t Create ID fi les” - This checkbox (on by default) prevents DiskTracker from creating ID 
files on disks being scanned.  This setting is described in more detail earlier in this chapter. 
 
 
“Scan into archives:” - Checkboxes under this subheading control the scanning of StuffIt™ 
and Compact Pro™ archive contents.  Check the boxes next to the types of archives DiskTracker 
should scan into.  Switching these checkboxes on increases scan time. 
 
 
“Scan optional data:” - Checkboxes under this subheading control the scanning of additional, 
optional data.  If these options, which by default are turned off, are enabled, the disk scanner 
will function more slowly and saved catalog files will require more disk space. 
 
These include: 
 

“Fi le version numbers” - If this checkbox is set, file version numbers will be 
scanned. 

 
“Finder comments” - If this checkbox is set, Finder comments will be scanned. 

 
 
“Match disks to catalogs with the same:” - Checkboxes under this subheading set the 
criteria used to identify which disk catalog matches a physical disk.  By default, disks will be 
matched by both name and creation date.  Either of these can be disabled if DiskTracker is 
incorrectly matching disks. 
 
 
“Scan size:” - The radio buttons under this subheader set DiskTracker to scan either an item’s 
physical size (how much space the file uses on a disk) or logical size (the actual number of 
bytes used by a file).  These sizes differ due to allocation block issues (a file may not 
necessarily use all of the disk space allocated for it). 
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CHAPTER TWO: The catalog window 
 
Once disks are scanned into a disk list, it is easy to browse the contents of those disks in the 
catalog window.  This window behaves much like the file lists in the MacOS Finder.  The list may 
be expanded to show the contents of a folder, while still keeping accessible all of the other 
items that were previously visible.  In addition, folders may be opened normally, so that folder’s 
contents are the only items visible. 
 
When a catalog file is first opened or created, a list of all the disks which have been scanned is 
presented.  This is the “All Disks” view, as indicated by the window’s title bar and a box in the 
upper left-hand corner of the window: 
 

 
 
 
 
 
Adjusting view hierarchies 
To show the contents of one disk or folder in the catalog window, select the disk or folder in the 
catalog window and choose “Open” from the Item menu.  Alternatively, double-click on the 
item, press command-down arrow, or press � � O. 
 
 
To go up a level in the hierarchy, click on the up-hierarchy button in the control bar at the top 
of the window: 

 
 
Alternatively, press command-up arrow. 
 
 
In the upper left-hand of the window is a box displaying the name of the folder or disk whose 
contents are being viewed in that window.  If the view is of the entire disk list, the box reads 
“All Disks”.  Clicking on this box pops up a menu showing the current path of the folder whose 
contents are being viewed.  Selecting one of the items from the path displayed in this menu will 
show the contents of that item in the window.  This menu may also be displayed by holding 
down the command key and then clicking on the title bar of the catalog window. 
 
To expand or collapse the hierarchy of a folder or disk, click on the triangle next to its name.  A 
triangle pointing to the right indicates a collapsed hierarchy, while one pointing downwards 
indicates an expanded hierarchy.  Option-clicking the triangle expands or collapses the 
hierarchies of the selected item as well as the hierarchies of all items within it. 
 
closed: 

 
 
opened: 
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Alternatively, click on an item and press command-right arrow to expand a hierarchy or 
command-left arrow to collapse a hierarchy.  Pressing option-command-right arrow expands the 
hierarchy of the selected item as well as the hierarchies of all items within it.  Option-command-
left arrow collapses the hierarchy of the selected item as well as the hierarchies of all items 
within it. 
 

NOTE - StuffIt™ and Compact Pro™ archives and self-extracting archives behave 
just like disks or folders.  These archives are most easily identified by a file or 
application icon with the expansion control triangle next to it.   Items 
contained within archives are identified by a “C-clamp” icon next to the item’s 
type in the “Kind” column. 

 
 
 
 
Selecting items 
Because DiskTracker’s catalog window is so similar to the Finder’s windows, most of the 
shortcuts which work for selecting an item in the Finder will also work in DiskTracker. These 
include: 
 

• Click on the item to select it.  Shift-click selects more than one item. 
 
• Start typing the name of the item - DiskTracker will select the item with closest 

name to that typed. 
 
• Click in the empty space surrounding the items and drag the mouse over the 

items to select. 
 
• Choose “Select All” (or hit � A) from the Edit menu to select all visible items in the 

catalog window. 
 
 
Once an item is selected, there are several ways to select another. 
 

• Use the up and down arrows to select the previous or next items in the list. 
 
• Use the Tab key to select the next item alphabetically in the list.  Shift-Tab 

selects the previous item alphabetically in the list. 
 
 
 
 
Selection size indicator 
At the bottom-left of the window is an indicator that shows how many items are selected and 
their total size.  This indicator will not appear if the catalog window is too narrow. 
 

NOTE - The size of the folder is equal to the size of all of the files within it.  Thus, if 
an expanded folder and its all of its contents are selected, the indicator will 
show the selected size to be twice the size of the contents of the folder. 

 
 
 
 
 



DiskTracker User Manual          Page 17

Getting item information 
For any selected item(s), DiskTracker can show a detailed information window similar to the 
Finder’s “Get Info”.  To get information for a particular item or for a group of items, select the 
items and then select “Get Info” from the Item menu (or press � I).  The information window 
will appear.  If more than one item was selected, use the scroll bar at the bottom of the window 
to show information for each of the individual items. 
 
DiskTracker can also show an expanded information window which is capable for showing item 
information for two separate items, allowing them to be compared side-by-side.  To enable this 
expanded information window, select “Split Info Window” from the Item menu.  This menu 
item may be selected either when a catalog window is visible or when the information window is 
visible.  Selecting “Spl it Info Window” again will return the window to its more compact form.  
When the information window is expanded, two scroll bars will be accessible to choose items to 
be viewed in each pane. 
 

NOTE - If the “Get Info” command is issued when only one item is selected, the 
window will always be shown in its compact form. 

 
 
 
 
Showing and hiding all hidden items 
DiskTracker can be made to show all of the items marked as hidden.  To toggle showing hidden 
items, use the “Show Hidden Items” item under the View menu.  By default, hidden items are 
not shown. 
 
 
 
 
Showing and hiding items 
DiskTracker can make a selected item hidden.  Hidden items do not appear in the disk catalog 
listing when DiskTracker has “Show Hidden Items” (described above) switched off.  This helps 
prevent clutter in the catalog window. 
 
• Hiding items: 
 

1.) Select items to be hidden. 
 
2.) Choose “Hide Item” from the Item menu (or press � � H, option-command-H). 

 
 
• Showing items: 
 

1.) Make sure that all hidden items are being shown.  If they are not being shown, 
select “Show Hidden Items” from the View menu. 

 
2.) Select the items to be shown. 
 
3.) Choose “Show Item” from the Item menu (or press � � H). 
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Launching, displaying, getting Finder information, & sharing privileges 
It is possible to launch, display in the Finder, get Finder information for, and set sharing 
privileges for files, applications, and folders from DiskTracker.   
 
• Launching items: 
 

1.) Select items to be launched. 
 
2.) Choose “Launch” from the Item menu (or press � L).  Alternatively, double 

click on files and applications in the catalog window to launch them, or select 
them and choose “Open” from the Item menu (or press � � O). 

 
3a.) If the disk which contains the items to be launched is mounted, the items will 

be launched just as if it had been opened from the Finder. 
 
3b.) If not, and DiskTracker cannot find the disk on its own, the disk locator dialog 

box will be presented.  (See below) 
 
 

NOTE - Launching a folder will open that folder in the Finder. 
 
 
• Showing items in the Finder: 
 

1.) Select items to be shown in the Finder. 
 
2.) Choose “Show in Finder” from the Item menu (or press � E). 
 
3a.) If the disk which contains the items to be shown is mounted, the items will be 

shown in the Finder. 
 
3b.) If not, and DiskTracker cannot find the disk on its own, the disk locator box will 

be presented. 
 
 
• Showing Finder Information for items: 
 

1.) Select items to have the Finder “Get Info” window viewed. 
 
2.) Choose “Get Finder Info” from the Item menu (or press � � I). 
 
3a.) If the disk which contains the items to be shown is mounted, the “Get Info” 

window for the items will be shown in the Finder. 
 
3b.) If not, and DiskTracker cannot find the disk on its own, the disk locator box will 

be presented. 
 
 
• Showing sharing privileges for items: 
 

1.) Select items for which the sharing privileges dialog box is to be viewed. 
 
2.) Choose “Sharing…” from the Item menu. 
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3a.) If the disk which contains the items to be shown is mounted, the sharing 
privileges dialog box for the items will be shown in the Finder. 

 
3b.) If not, and DiskTracker cannot find the disk on its own, the disk locator box will 

be presented. 
 
 
 
 
The disk locator dialog box 
 

 
 
If DiskTracker is unsuccessful in locating the disk on which a file to be operated on is found, it 
may present the disk locator dialog box (older Classic Mac OS versions only). 
 
Use this dialog to: 

 
• Browse all of the on-line disks (use the “<<” and “>>” buttons). 
 
• Eject a mounted disk (the “Eject” button). 
 
• Have DiskTracker check to see if the file in question is on a particular disk (make 

sure that the disk is visible in the box and click “OK”). 
 
• If the disk that DiskTracker is looking for is inserted while this dialog is visible, the 

locator box will immediately go away and the operation is continued. 
 
• To abort the operation, click “Cancel”. 

 
 
 
 
Setting item attributes 
DiskTracker 2 has the ability to alter a cataloged item’s attributes.  This includes the item’s 
name, Finder label, Finder comment, creation and modification dates, and more.  When a 
cataloged item’s attributes are modified, DiskTracker will change the attributes for the actual 
item as well.  If the disk containing the actual item is not available to DiskTracker, it will prompt 
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for the disk with the disk locator dialog.  If the disk is not found, no modification to the item will 
take place in either the disk catalog or on the disk itself. 
 
• Setting an item’s attributes: 
 

1.) Select the item whose attributes are to be altered. 
 
2.) Choose “Set Item Attributes…” from the Item menu. 
 
3.) The dialog presented differs based on the class of the item being edited.  See 

below for a complete list of the attributes allowed for each class of item. 
 
4.) Click “OK” to commit the changes.  DiskTracker will make the requested 

changes only if the disk containing the actual item can be found (use the disk 
locator dialog box to choose the correct volume, if necessary).  “Cancel” 
aborts the edit. 

 
Item attributes that can be altered for files: 

• File Name 
• Finder Label 
• File Type & Creator 
• Creation Date & Modification Date 
• Finder comment 
• File lock 
• File invisibility (shows/hides the file in the Finder) 
• File hidden (shows/hides the file in DiskTracker) 

 
Item attributes that can be altered for folders: 

• Folder Name 
• Finder Label 
• Creation Date & Modification Date 
• Finder comment 
• Folder lock 
• Folder invisibility (shows/hides the folder in the Finder) 
• Folder hidden (shows/hides the folder in DiskTracker) 

 
Item attributes that can be altered for volumes: 

• Volume Name - This is the real name assigned to a disk.  This can only be set if 
sharing is not enabled for the disk. 

• Catalog name - This name assigned to the disk catalog.  This name is shown in the 
DiskTracker catalog.  Change this name if there are several disks with the 
same name and a distinction must be made between the disks.  Changing the 
catalog name will not make any changes to the actual disk, and DiskTracker 
will still be able to identify the actual disk. 

• Serial Number 
• Finder Label 
• Disk Type - When scanning a disk, DiskTracker will make its best guess as to the 

type of the disk being scanned.  If the guess in incorrect, set the actual disk 
type with this popup menu.  Changing the disk type will not make any changes 
to the actual disk. 

• Creation Date & Modification Date 
• Finder comment 

 
 



DiskTracker User Manual          Page 21

 
 
Setting item names from the catalog window 
It is possible to quickly change the name of an item from the catalog window.  After changing 
the item’s name, DiskTracker will prompt for the insertion of the original disk, if necessary.  The 
name of the actual item will then be changed.  When changing volume names this way, the 
catalog name will be changed, not the actual disk name.  Use “Set Item Attributes”, 
described above, to change the actual disk name. 
 
• Changing an item’s name: 
 

1a.) Select an item disk in the catalog window using the mouse (click on it).  Leave 
the mouse stationary for a brief moment after the click.  A text box will 
appear in place of the item’s name. 

 
1b.) Alternatively, select the item using any method, and then press the return 

key. 
 
2.) Type the new item name. 
 
3.) Press the return key to commit to the new item name.  Press the escape key 

to cancel the name change. 
 
4.) DiskTracker will change the name of the item in the catalog and on the original 

disk.  The disk locator box will appear if the disk is not currently mounted.  
 
 
 
 
Setting Finder labels from the catalog window  (Classic Mac OS only) 
 
• Changing an item’s Finder label: 
 

1.) Select items in the catalog window whose Finder labels are to be altered. 
 
2.) Choose a new Finder label from the “Finder Label” submenu of the Item 

menu. 
 
3.) DiskTracker will set the label of the item in the catalog and on the original disk.  

The disk locator box will appear if the disk is not currently mounted. 
 
 
 
 
Editing item notes 
A short (250 characters or so) note can be associated with each item in a disk catalog.  This 
note appears in the Get Info box and can appear on a disk label (see chapter six).  The item 
notes are preserved across disk updates. 
 
• Editing an item note: 
 

1.) Select the item whose item note is to be changed. 
 
2.) Select “Set Item Note…” from the Item menu. 
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3.) Type a note for the item. 
 
4.) Click “OK” (or hit Enter) to commit to the new disk note or click “Cancel” to 

abort. 
 
 
 
 
Making new folders 
DiskTracker can create new folders on disks that are cataloged.  If the disk on which the folder 
is to be created is not mounted when a new folder is created, the disk locator dialog box will 
prompt for its insertion. 
 
• Creating a new folder: 
 

1.) Double-click on the folder in which the new folder is to be created. 
 
2.) Select “New Folder” from the Item menu (or press � � N). 
 
3.) Type a name for the new folder and press return when done. 
 
4.) DiskTracker will prompt for the insertion of the original disk (with the disk 

locator dialog box), if necessary. 
 
 
 
 
The contextual menu 
Like the Finder, DiskTracker has a contextual menu that can be invoked for a specific item.  This 
menu contains all of the operations that can be performed on the item.  For instance, many of 
the commands in the Edit and Item menus are also offered in the contextual menu. 
 
• Using the contextual menu: 
 

1.) Hold down the Control key and click on the item whose contextual menu is to 
be invoked. 

 
2.) Select a command from the menu that pops up from under the cursor. 

 
 
 
 
Copying/Moving items 
DiskTracker can be used to move or copy items.  Drag items to other folders in DiskTracker or 
the Finder to copy or move the items.  If the drag destination is on the same disk as the source 
item, the item will be moved.  If it is not, the item will be copied. 
 
• Copying or moving items from DiskTracker: 
 

1.) Select the items to move/copy. 
 
2.) Drag the items to a folder in DiskTracker or in the Finder. 
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3.) If the destination is on the same disk as the source item, the item will be 
moved.  Otherwise it will be copied.  When dragging to the same disk, hold 
down the option key to force DiskTracker to copy the items. 

 
 
 
 
Deleting items from catalogs 
Items can be moved to the trash or deleted directly from DiskTracker.  This can be done by 
dragging to the Finder’s “Trash” icon, or by using commands in the Item menu. 
 
• Moving an item to the trash: 
 

1.) Select the items to be trashed. 
 
2a.) Drag the items to the Finder’s “Trash” icon. 
 
2b.) Alternatively, choose “Put In Trash” from the Item menu. 

 
 
• Deleting an item directly without moving it to the trash: 
 

1.) Select the items to be deleted 
 
2.) Choose “Delete…” from the Item menu.  Confirm the deletion by clicking 

“OK” in the resulting alert box. 
 
 
 
 
Emptying the Trash 
 
• Emptying the trash from DiskTracker: 

 
1.) Choose “Empty Trash…” from the Item menu.  Confirm the command by 

clicking “OK” in the resulting alert box. 
 
 
 
 
Moving disk catalogs 
To reduce disk-rescanning, disk catalogs can be moved from one catalog file to another.  
DiskTracker supports standard cut, copy, and paste as well as drag and drop to allow this. 
 
• Moving disks from one catalog to another using Cut/Copy/Paste: 
 

1.) Select the disks to be moved in the catalog window (make sure that only disks 
are selected). 

 
2.) To keep a copy of the disk catalog in the original catalog file, select “Copy 

Disk” from the Edit menu (or press � C).  Otherwise, choose “Cut Disk” (� X) 
from the Edit menu. 

 
3.) Select the catalog window into which you would like to paste the disk. 
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4.) Choose “Paste Disk” (� V) from the Edit menu. 

 
 
• Copying disks from one catalog to another using drag and drop: 
 

1.) Select the disks to be moved in the catalog window (make sure that only disks 
are selected). 

 
2.) Drag the disks from their source catalog window to another catalog window.  

The disks will be copied to the other catalog window. 
 

NOTE - If a disk being moved/copied has the same serial number as one in the 
target catalog list, DiskTracker will ask if it should assign a new serial number 
to the disk being moved/copied.  Click “Yes” to assign a new serial number to 
the disk, “No” to prevent the disk from being moved, or “Cancel” to stop the 
entire operation.  

 
 
 
 
Removing disk catalogs 
 
• Removing disks from the catalog list:  
 

1.) Select the disks to be deleted in the catalog window (make sure that only 
disks are selected). 

 
2a.) Choose “Clear Disk” from the Edit menu, or hit the delete key. 
 
2b.) Alternatively, drag the disk catalog icon to the Finder’s “Trash” icon. 

 
NOTE - It is possible to undo a disk clear (choose “Undo Clear Disk” from the Edit 

menu). 
 
 
 
 
Saving and opening catalog files 
DiskTracker has the standard Macintosh New, Open, Close, Save, Save As, Revert, and Quit 
commands for dealing with files. 
 

• New (� N) - Creates a new, empty catalog file.  All of the file preferences are set 
to the application defaults. 

 
• Open (� O) - Presents the standard open file dialog allowing a catalog file to be 

opened.  If they shift key is held down, this option becomes “Open (read-
only)…” allowing users to open files read only.  Opening files this way allows 
multiple copies of DiskTracker on different machines to have the same catalog 
file opened. 

 
• Close (� W) - Closes the current front most window.  If the window has not been 

saved since the catalog has been changed, DiskTracker will ask if the file 
should be saved. 
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• Save (� S) - Saves the file or performs a Save As if the file has never been saved. 
 
• Save As… - Presents the standard save file dialog allowing the catalog file to be 

saved to a particular location. 
 
• Revert - Returns the disk catalog file to its last saved state. 
 
• Quit  (� Q) - Closes all windows, asking to save all that have not been saved, and 

then quits back to the Finder. 
 
 
 
 
Printing catalog files 
Naturally, the contents of a DiskTracker catalog window can be printed.   
 
• Printing a catalog listing: 
 

1.) Choose “Page Setup” (from the File menu) and verify the settings for the 
printer and paper type. 

 
2.) Select “Print” from the File menu (or press � P). 
 
3.) Select print copies, page ranges, print quality, etc. from the upper section of 

the print dialog box. 
 
4.) If there is a pop-up menu in the upper left corner of the print dialog box, 

select “DiskTracker” from this menu. 
 
5.) Select either to print “All Items” or only the “Visible Items” by choosing 

the appropriate radio button.  If “All Items” is set, all of the items in the 
current hierarchy will be expanded and printed.  If “Visible Items” is set, only 
the items that are currently visible in the catalog window will be printed.  
Printing Visible items most closely resembles the Finder’s “Print Window…” 
command. 

 
6.) Click “Print” to start printing, or “Cancel” to abort. 

 
 
NOTE - If Print “All Items” is selected, the current file sorting options will be 

ignored (see chapter 3 for more information on file sorting) (volume sorting 
options will remain intact).  This frees DiskTracker from having to sort all of 
the files in a catalog file (which can be a rather time-consuming process) 
whenever all items are printed.  If “Visible Items” is selected, the list will 
appear just as it does in the window (including the current file sort method). 

 
TIP - If you are willing to wait for DiskTracker to sort all of the items within the 

current hierarchy, it is possible to print all items with the current file sort 
method.  To do this, choose “Select Al l” from the Edit menu (� A) and press 
option-command-right arrow.  This entirely expands the current hierarchy.  
Now, by printing visible items, you can reproduce the effects of printing all, 
but with file sorting intact. 
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CHAPTER THREE: Customizing DiskTracker  
 
The look and functionality of DiskTracker’s catalog window can be customized as needed.  
Customizations include fonts and sizes, file and volume sort orders, and pieces of information 
shown in the catalog window. 
 
Other DiskTracker customizations are performed through the Preferences dialog boxes, also 
described in this chapter. 
 
 
 
 
Dividing the catalog window 
DiskTracker features a dual pane catalog window.  This allows viewing of two portions of the 
same catalog list, even if they are opposite ends of the scroll bar. 
 
• Dividing the catalog window into two panes: 
 

1.) Click and drag the thick black bar at the top of the scroll bar downwards to 
the point where the window is to be split.  An additional vertical scroll bar will 
appear to allow scrolling of the second pane. 

 
 
• Restoring the catalog window to one pane: 
 

1.) Click on the thick black bar between the two vertical scroll bars and drag it to 
the top of the window. 

 
 
 
 
The information header 
The information header is a strip that DiskTracker shows across the top of the catalog window.  
It contains such useful pieces of information as the number of volumes, files, and archives in the 
catalog, as well as the number of items visible and the amount of free storage on the disk on 
which the catalog is saved (if it has been saved). 
 
• Hiding the catalog header, or showing it once it is hidden: 
 

1.) Select “Show Info Header” from the View menu. 
 
 
 
 
Selecting list views 
It is possible to choose which pieces of information DiskTracker shows in the catalog window.  
By default, the name, size, kind, and modification date fields are shown, but there are quite a 
few other information columns that can be shown.   
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• Altering the list views: 
 

1.) Select “List Views…” from the View menu. 
 

 
 
2.) Check the column views to make visible and uncheck those to hide. 
 
3.) Click the “OK” button to commit to the new settings or click “Cancel” to 

abort. 
 
 
 
 
Rearranging data columns 
The individual columns of data can be reordered by moving them around. 
 
• Moving a column: 
 

1.) Move the mouse pointer over the title of the column to be moved.  The cursor 
will become a hand: 

 

 
 
2.) Holding down the mouse button, drag the column to its new location.  When 

the mouse button is released, the column will move to its new location, being 
placed before whichever column was previously there. 
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Resizing data columns 
Individual columns of data can also be resized. 
 
• Resizing a column: 
 

1.) Move the mouse pointer over the column divider line to the right of the title of 
the column to be resized.  When the cursor is over this divider line, it will 
become the resize cursor: 

 

 
 
2.) Holding down the mouse button, drag the column to its new width.  Release 

the mouse button and the new size will be locked in. 
 
 
 
 
Sorting files and volumes 
DiskTracker allows different sorting methods to be selected for both volumes and files/folders.  
By default, both of these are set to be sorted ascending by name. 
 
• Alter the sorting method used: 
 
For volumes: 
 

1.) From the “Sort Volumes By” submenu in the View menu, select the sort 
criteria to be used for sorting the disk list. 

 
2.) From this same menu, choose whether to sort the volumes in ascending or 

descending order. 
 
 
For files and folders: 
 

1.) From the “Sort Fi les By” submenu in the View menu, select the sort criteria 
to be used for sorting the files and folders. 

 
2.) From this same menu, choose whether to sort the files and folders in 

ascending or descending order. 
 
The file/folder and volume sorting order may be also changed by clicking on the title of the 
column to sort by. 
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General Preferences 
DiskTracker's general settings can be adjusted through the “General Preferences” dialog box.  
This dialog box is invoked by selecting “General…” from the “Preferences” submenu of the 
Edit menu. 
 
“Text export settings:” - Items under this section determine the behavior of DiskTracker’s 
“Export As TEXT…” functionality.  See chapter eight for more information on this feature. 

 
“Text fi le creator:” - Set this to the four letter creator code of the desired 

application to be launched when the saved text files are double-clicked.  Use 
the “Get From File…” button to select the application or a document 
created by the application to fill this field in automatically. 

 
“Indent l ines with:” - Select the character to be used to indent lines.  That is, 

DiskTracker will use this character to signify how deep an item is in the catalog 
hierarchy.  Choose “Other…” from the menu to bring up a dialog where other 
indent characters (up to four) may be entered.  

 
“Delimit fields with:” - This character is used to separate the fields in a row of 

exported data for an item. 
 

“Store scratch data on:” - DiskTracker will use drive space on the selected hard drive to 
save its virtual memory scratch files.  By default, this is set to the startup volume, but it can be 
changed if there is insufficient drive space on that volume. 
 
“Save catalog window positions” - If this checkbox is set, catalog window locations and 
positions will be saved.  Thus catalog windows will “remember” where they were when they were 
last saved, and will open in the same place.  (off by default) 
 
“Faster batch scanning (disables “Stop” button)” - This checkbox activates the fast 
batch scanner.  Fast batch scanning prevents the Finder from ever mounting a disk, but disables 
the “Stop” button and also the ability to put DiskTracker in the background during a batch scan.  
Turn this option when using the batch scanner to scan a number of small volumes (e.g., floppy 
disks) to improve scanning speed drastically.  (on by default). 
 
“Open last used files when DiskTracker is run” - When this checkbox is set, DiskTracker 
will, on startup, reopen the files that were last open when DiskTracker was last quit.   If the files 
were manually closed before quitting the application, however, they will not be reopened.  (on 
by default) 
 
“Show DiskTracker splash screen” - Turning this checkbox off disables the DiskTracker 
splash screen, which is shown whenever the program starts up.  Disabling the splash screen will 
make DiskTracker launch faster.  (on by default) 
 
“Warn before emptying trash” - If this checkbox is set, DiskTracker will ask for verification 
before emptying the trash (when the “Empty Trash…” command is selected from the Item 
menu).  (on by default) 
 
“Open catalog f iles read-only by default” - If this checkbox is set, DiskTracker will, by 
default, open files read-only.  This is useful for situations where multiple DiskTracker users are 
opening catalog files from file servers, but are not modifying them.  If the files are opened read-
only by default, the files will still be able to be opened by other users.  Holding the shift key 
down while selecting “Open” from the File menu will open a file normally when this option is set.  
(off by default) 



DiskTracker User Manual          Page 30

 
 
 
 
Defaults Preferences 
DiskTracker’s default behaviors are controlled from the “Defaults Preferences” dialog box.  This 
dialog box is brought up by selecting “Defaults…” from the “Preferences” submenu of the 
Edit menu. 
 
“Default catalog window size:” - The two popup menus under this section control the 
window size for new catalog windows.  The height of the window can be set to small, medium, 
or full screen.  The width can be small, medium, or large.  Note that this setting represents a 
maximum bound for the width of the window, however.  A catalog window will never, by default, 
be wider than the data being displayed in it. 
 
“Default label template:” - This is the label template that is assigned to disks as they are 
scanned.  For more on label templates, see chapter six. 
 
“Default label sheet layout:” - This is the label sheet layout that is selected as the current 
label sheet layout whenever DiskTracker is started.  For more on label sheet layouts, see chapter 
six. 
 
“Replace settings:” - The two buttons contained within this section copy default settings 
between the application and the current front most catalog window.  These settings include sort 
orders, data column positions, and other catalog-window specific settings. 

 
“Application Settings” - Replaces the default application catalog window settings 

with the settings of the front most window. 
 
“Catalog Settings” - Replaces the settings of the front most catalog window with 

the application defaults. 
 
 
 
 
View Preferences 
To change the fonts, sizes, and icons that DiskTracker to draw and print the catalog list, use the 
View Preferences dialog box, accessed from the “View…” item under the “Preferences” 
submenu of the Edit menu. 
 
 
“Catalog display style:” - Choose the font, text size, and icon size to draw the catalog 
display window.  The sample will change to demonstrate what an item might look like drawn in 
the styles selected. 
 
“Catalog printing style:” - Choose the font, text size, and icon size in which to print a 
catalog listing.  The sample will change to demonstrate what an item might look like drawn the 
styles selected. 
 

NOTE - The text style (e.g., bold, italic, etc.) in which the file list is shown cannot 
be changed.  Disk names are always shown in bold and alias names are always 
shown in italics. 
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“Report windows use catalog font” - When this checkbox is set, all report windows (the 
search result window and disks to be labeled list, described later) are drawn using the same font 
as the catalog list.  This is useful when a font other than Geneva must be used to draw the 
report window, for instance, to draw localized text.  (off by default) 
 
“Allow condensed text in catalog window” - Setting this checkbox will cause DiskTracker 
to, if necessary, use a condensed font to draw text into narrow data columns.  Since this 
condensed text is often difficult to read, this can be switched off.  (on by default) 
 
“Draw grid in catalog/report window” - If this checkbox is set, DiskTracker will draw the 
gray background grid into the background of catalog and report windows.  With the grid on, 
DiskTracker looks more like the MacOS 8.x and later; with it off, MacOS 7.x.  (on by default) 
 
“Show time with date in catalog/report windows” - When this checkbox is set, 
DiskTracker will include the time when drawing dates in the catalog or report window.  This 
requires more space and can cause extra clutter, but provides more information.  (off by 
default) 
 
“Use relative date” - When this checkbox is set, DiskTracker will use the words “Today” and 
“Yesterday” in place of appropriate dates.  (on by default)    
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CHAPTER FOUR: Searching catalog files 
 
DiskTracker offers several methods of searching for items. 
 
Searches can be performed using either the “Find” or “Find Using Filter” search mechanisms.  
Both of these mechanisms allow multiple-criteria searches - rather than simply searching for 
items using a single criteria (e.g., ‘Name is “Fruit Salad”’), these searches allow multiple search 
terms (e.g., ‘Name contains “Egg Nog” AND attribute is alias’).  AND, OR, and XOR Boolean 
operators offer flexibility in how search parameters are combined. 
 
DiskTracker offers searches on over twenty different types of criteria.  The individual “hits” 
(found items), can be shown either individually in the catalog window, all at once in the catalog 
window, or in a search result window (described in chapter five). 
 
DiskTracker can perform even more advanced multi-parameter searches using item filters.    
Essentially, an item filter is a collection of criteria which describe an item.  Item filters can 
contain as many criteria as needed and can group criteria.  Item filters can be saved to disk, so 
filters for common searches only need to be made once. 
 
DiskTracker also contains a powerful duplicate item finding facility.  Choose which item criteria 
determine a duplicate file, specify an optional item filter to reduce the number of items 
examined, and DiskTracker will quickly find all of the files which are duplicated elsewhere in the 
disk catalog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



DiskTracker User Manual          Page 33

 
 
 
The Find dialog box 
DiskTracker features a simple searching engine which most users will find sufficient for their 
searches.  Up to six criteria may be checked at a time and over twenty different kinds of criteria 
are offered. 
 
 
• Executing a single-criteria search: 
 

1.) Select “Find…” from the Search menu (or press � F).  The Find dialog box will 
be presented: 

 

 
 
2.) Select whether DiskTracker should search all disks, the current hierarchy, 

within selected items, or selected items only from the “Search” menu within 
the dialog. 

 
3.) Select the criteria to search on from the menu on the left.  For a list of the 

criteria and what they do, see below. 
 
4.) Select the how the criteria should be matched (e.g., contains, is equal to, is 

less than, and so forth) from the menu on the right. 
 
5.) Enter the search value or select it from the menu in the center (method 

depends on the search criteria).  Click the “Match Case” checkbox to ensure 
case-sensitive searches.  See below for more information. 

 
5a.) To search on more than one criteria, click the “More Choices” button.  This 

will add a search term to the search.  The button is grayed out if there are 
already six search criteria visible.  Complete steps 3 - 5 for the new search 
criteria, and choose either “AND” or “OR” from the pop-up menu to indicate 
how the criteria should be combined. 

 
5b.) To remove the last criteria from the dialog box, click the “Fewer Choices” 

button. 
 



DiskTracker User Manual          Page 34

6.) From the “Show:” menu, select how DiskTracker should display the found 
items.  Choose between having the first item selected, all of the items 
selected, or the items displayed in the search result window (for more on the 
search result window, see the next chapter). 

 
7.) Click the “Find” button to start the search, or the “Cancel” button to cancel. 

 
 
The search criter ia: 

name - An item’s name.  Fill in the name field. 
size - An item’s size.  For disks, this is the amount of space used on the disk.  Fill in 

the size field in kilobytes. 
kind - An item’s kind.  Fill in the kind field. 
label - An item’s Finder label.  Select from list of labels. 
type - A file’s four letter type code.  This will never find volumes or folders.  Fill in 

file type or click on the “Get From File” button and select a file from the open 
dialog. 

creator - A file’s four letter creator code.  This will never find volumes or folders.  
Fill in file creator or click on the “Get From File” button and select a file from 
the open dialog. 

creation date - The date on which an item was created.  Click on the month, day, 
and year then use arrow buttons to select the date. 

modified date - The date on which an item was last modified.  Click on the month, 
day, and year then use arrow buttons to select the date. 

attribute - Several different attributes including: “is the item locked?”, “is the item 
invisible?”, “an alias?”, “hidden?”, “a volume?”, “a folder?”, “an archive?”, “a 
file?”, and “does the item have an obsolete disk label?”.  Select the attribute 
from the popup menu. 

depth - How deep an item is within the hierarchy.  Volumes are of depth 1.  Fill in 
the depth in the field. 

item note - An item’s item note, as entered through the “Item Notes” dialog.  Fill 
in the text field. 

 
version - A file’s version number.  This will never find folders or volumes, and will 

not find any files which do not have version numbers.  Fill in the version 
number field. 

finder comment - An item’s Finder comment.  Fill in the comment field. 
 
chi ldren items - How many items there are within the first level of an folder or 

disk’s hierarchy.  The only files that this will ever find are archives.  Fill in the 
number of children in the field. 

total  items - How many items there are within the entire hierarchy of a folder or 
disk, including the hierarchies within that folder or disk, and the ones inside of 
that, and so on.  The only files that this will ever find are archives.  Fill in the 
number of descendants in the field. 

 
disk type - A volume’s disk type.  Select a type  from the popup menu. 
scanned date - The date that a disk was last scanned.  This will never find folders 

or files.  Click on the month, day, and year then use arrow buttons to select 
the date. 

labeled date - The date that a disk was last labeled.  This will never find folders or 
files.  Click on the month, day, and year then use arrow buttons to select the 
date. 
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free space - The free space on a disk.  This will never find folders or files.  Fill in 
the size in kilobytes. 

serial number - The disk’s serial number.  This will never find folders or files.  Fill in 
the serial number field. 

 
parent name - The name of an item’s parent.  This will never find volumes. Fill in 

the name field. 
ancestor name - The name of an item’s ancestor.  This will never find volumes.  

Fill in the name field. 
 
 
 
 
Searching with item filters 
For more complex searches, DiskTracker offers an extremely powerful multiple parameter item 
filter searching system.  To use this system, define an item filter to use (or select a saved 
filter).  Item filters can contain unlimited criteria and offers grouping as well as the AND, OR, and 
XOR binary combination operators. 
 
• Finding items using item filters: 
 

1.) Select “Find Using Fi lter…” from the Search menu (or press � � F).  
DiskTracker will present the Find Using Filter dialog: 

 

 
 
2.) Select whether DiskTracker should search all disks, the current hierarchy, 

within selected items, or selected items only from the “Search” menu within 
the dialog. 

 
3.) Select an item filter from the filter pop up menu or choose the “<untitled 

filter>”.  (more on editing item filters below) 
 
4.) From the “Show:” menu, select how DiskTracker should display the found 

items.  Choose between having the first item selected, all of the items 
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selected, or the items displayed in the search result window (for more on the 
search result window, see the next chapter). 

 
5.) Click the “Find” button to start the search, or “Cancel” to cancel. 

 
 

NOTE - The “untitled filter” is a temporary item filter which will be lost when 
DiskTracker quits.  You can use the untitled filter for item filters that you do 
not wish to be saved on the disk.  If you would like to save the untitled filter 
to disk, you can use the “Save As…” filter management button (see below). 

 
 
 
 
Managing item filters 
Any of the following steps can be issued from a dialog box which has the item filter 
management controls.  This includes the “Find Using Filter” dialog, the “Find Duplicate Files” 
dialog, or the “File List Filter” dialog (described later). 
 
• Creating a new filter: 
 

1.) Within the filter management dialog, click on the “New…” button. 
 
2.) Enter a name for the filter into the name dialog. 
 
3.) The filter editor dialog will be presented.  See below for information on the 

filter editor. 
 
4.) Be sure to click “OK” to exit the editor, or else the filter will not be saved. 

 
 
• Saving a filter as a different name: 
 

1.) With the appropriate filter selected in the filter management dialog’s popup 
menu, click on the “Save As…” button. 

 
2.) Enter the name to save the filter as. 
 
3.) Click on the “OK” button to save the filter, or “Cancel” to abort. 

 
 
• Deleting a filter: 
 

1.) With the filter to be deleted selected in the filter management dialog’s popup 
menu, click on the “Delete…” button. 

 
2.) DiskTracker will ask to confirm the choice to delete the item.  Click “Delete” 

to delete the filter or “Cancel” to abort. 
 
 
• Editing a filter: 
 

1.) With the filter to be edited selected in the filter management dialog’s popup 
menu, click on the “Edit…” button. 
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2.) The filter editor dialog will be presented.  See below for information on the 

filter editor. 
 
3.) Be sure to click “OK” to exit the editor, or else the filter will not be saved. 

 
 
 
 
The filter editor 
After creating a new filter or editing a previously created one, the filter editor dialog will be 
invoked.  This dialog has a large scrolling list of all of the criteria which make up the item filter.  
This list will, of course, be empty if the filter is new.  Create, group, and set relations for criteria 
within this dialog box to make an item filter. 
 

 
 
 
• Creating a new filter criteria: 
 

1.) Click the “Insert…” button within the item filter editor.  A dialog which 
resembles the top half of the single criteria search dialog will be presented. 

 
2.) Select the criteria to search on from the menu on the left.  For a list of the 

criteria and what they do, see the list above. 
 
3.) Select how the criteria should be matched (e.g., contains, is equal to, is less 

than, etc.) from the menu on the right. 
 
4.) Enter the search value or select it from the menu in the center (method 

depends on the search criteria).  See above for more information. 
 
5.) Click “OK” to add item to filter or “Cancel” to abort.  If a criteria was 

selected when “Insert…” was clicked, the new criteria will be added before 
that one.  Otherwise, the new criteria will be added to the end of the criteria 
list. 
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• Editing a criteria once it is in the list: 
 

1.) Select the item to edit. 
 
2.) Click on the “Edit…” button.  Alternatively, double click on the item to edit. 
 
3.) Select the criteria to search on from the menu on the left.  For a list of the 

criteria and what they do, see the list above. 
 
4.) Select the how the criteria should be matched (e.g., contains, is equal to, is 

less than, etc.) from the menu on the right. 
 
5.) Enter the search value or select it from the menu in the center (method 

depends on the search criteria).  See above for more information. 
 
6.) Click “OK” to commit the changes to the filter or “Cancel” to abort. 

 
 
• Removing an item from the criteria list: 
 

1.) Select the criteria to be removed.  Shift-click to select more than one item. 
 
2.) Click the “Delete” button.  The items will be removed from the list. 

 
 
 
 
About binary operators 
A binary operator takes two true/false values and combines them into a single true/false value.  
The combination method depends on the operator.  Binary operators are necessary within item 
filters because they define how the individual criteria combine to determine whether an item is 
matched by the item filter.   
 
The three binary operators offered by DiskTracker item filters are: 

AND - returns true only if the two criteria being compared are both true. 
OR - returns true if either or both of the two criteria being compared are true. 
XOR (exclusive OR) - returns true if either one of the two criteria being compared 

are true, but not if both are true. 
 
Whenever a new criteria is created, it uses the AND operator by default. 
 
 
• To changing the binary operator for filter criteria: 
 

1.) Select the item on the line which contains the operator to be changed. 
 
2.) Select a new operator from the pop up menu. 

 
 
 
 
Grouping 
In order to get certain criteria to be evaluated before others, groups of criteria can be combined 
into a single criteria.  Groups are shown in the filter criteria list within a pair of brackets (‘[’ and 
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‘]’), one at the beginning and one at the end of the group.  If no groups are present, the criteria 
are evaluated and combined from the first to the last (i.e., left to right).  If groups are present, 
the groups are evaluated into one truth value first, then the items are combined from first to 
last (as if the group were a single criteria).  It is possible to nest groups (i.e., have a group 
inside of another group). 
 
 
 
• Grouping two or more criteria: 
 

1.) Select the criteria to be grouped.  Shift-click to select more than one. 
 
2.) If the “Group” button is enabled, the items may be grouped.  Click on the 

“Group” button to group the criteria. 
 
 
• Ungrouping criteria: 
 

1.) Select the criteria within the list which make up a group. 
 
2.) If the “Ungroup” button is enabled, the items are indeed in a group and may 

be ungrouped.  Click on the “Ungroup” button to ungroup the items. 
 
 
 
 
Automatic item filter creation 
DiskTracker has an automatic item filter generation system - given a selected item, the 
generator will produce an item filter based on the characteristics of that file.  Choose which 
criteria to base this filter on as well as where to store the filter (either in a new filter or in the 
untitled filter) in the “Auto-Filter Options” dialog box. 
 
 
• To set the automatic filter generator options: 
 

1.) Select “Auto Filter Opt ions…” from the Search menu.  The Auto Filter 
Options dialog will be presented. 

 
2.) Check the criteria for the filter to include. 
 
3.) Choose whether the generator should save the filter as the untitled filter or as 

a new filter. 
 
4.) Click “OK” to commit the settings or “Cancel” to abort. 

 
 
• To produce an item filter automatically: 
 

1.) Select the one item to base the filter on. 
 
2.) Select “Make Filter From Item” from the Search menu (or press � T).  An 

item filter containing the specified criteria will be created and saved into either 
the untitled filter or into a filter with the same name as the item (as chosen in 
the Auto Filter Options dialog). 
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Finding duplicate items 
DiskTracker includes a powerful duplicate item search system.  This system will search for all 
files which are identical in several different user-specifiable criteria.  For instance, if the 
duplicate file locator is set to locate files by name and size, any two or more files which have 
the same name and size will be found.  In addition, an item filter can be used to reduce the pool 
of files which are to be examined for duplicates to make results more manageable and searching 
faster. 
 
• To set the criteria which must be matched for a file to be considered the duplicate of another: 
 

1.) Select “Duplicate Item Criteria…” from the Search menu.  The Duplicate 
Item Criteria dialog will be presented. 

 
2.) Check the criteria to have matched for a file to be considered the duplicate of 

another. 
 
3.) Click “OK” to commit the settings or “Cancel” to abort. 

 
 
• To search for duplicate files: 
 

1.) Select “Find Duplicate Items…” from the Search menu.  The Find Duplicate 
Items dialog will be presented: 

 

 
 
2.) Select whether DiskTracker should search all disks, the current hierarchy, 

within selected items, or selected items only from the “Search” menu within 
the dialog. 
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3.) To use an item filter to reduce the number of items examined, click the 

“Check only items which match the filter:” checkbox, and then select 
the filter from the pop-up menu.  Use the filter management controls to 
create new filters, edit filters, save filters, and delete filters, as described 
above. 

 
4.) Click the “Find” button to start the search or “Cancel” to cancel. 
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CHAPTER FIVE: The search result window 
 
After a search has been completed, the search result window will be shown (assuming that the 
search was set up to show the window and not select the first or all of the items).  The disks to 
be labeled window (described in chapter seven) is very similar to the search result window.  
These two windows, although used for different purposes, behave similarly. 
 
The main portion of the window is the scrolling list at the bottom of window.  This is where 
either the items found or the disks to be labeled are shown.  Select items from this list as you 
would from any other list, by clicking on them.  Command-click to select more than one item, or 
shift-click to select a range of items. 
 
At the top of each window is a region which displays either information about an individual item 
(or only one item is selected) or about a group of selected items.  Information similar to the 
“Get Info” window is shown when only one item is selected.  If more than one item is selected, 
this window portion will show the number of items in the list, the number of selected item, and 
the total size of the items. 
 
There are two ways of viewing the list of items.  One shows the item’s icon, name, size, kind, 
creation date, and modification date.  The other shows the item’s icon, name, containing disk’s 
serial number, and either path or disk label (depending on whether the window is a search result 
window or a disks to be labeled window, respectively). 
 
 
To switch the window’s mode, click on the mode switch box above the scroll bar: 
 

 
 
 
 
 
Sorting the item list 
The item list may be sorted by icon, name, size, kind, modification date, creation date, 
containing disk’s serial number, or path/disk label.  The current method used for sorting the 
items is shown by the underlined column header. 
 
• Changing the item sort method: 
 

1.) Click on the column header representing the method to sort the data by. 
 
 
 
 
Manipulating items 
It is possible to view a given item from the search result/label list window in the appropriate 
catalog window. 
 
• Viewing an item in its catalog window: 
 

1.) Double click on the item. 
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Many of the item operations that can be used in the DiskTracker catalog window (see chapter 
two) can also be performed in the search result window.  For instance: 
 
• Getting information on an item or group of items in the search result window/label list: 
 

1.) Select the items to get information for. 
 
2.) Select “Get Info” from the Item menu (or press � I). 

 
 
• Launching an item or group of items from the search result window/label list: 
 

1.) Select the items to be launched. 
 
2.) Select “Launch” from the Item menu (or press � L). 

 
 
• Displaying an item or group of items in the Finder from the search result window/label list. 
 

1.) Select the item or group of items to be shown. 
 
2.) Select “Show in Finder” from the Item menu.  

 
 
 
 
Printing and exporting 
The contents of the search result window/label list window may be printed. 
 
• To print the contents of the search result window/label list: 
 

1.) To print only certain items, select those items. 
 
2.) Make sure that the page setup settings are correct (select “Page Setup…” 

from the File menu). 
 
3.) Select “Print…” from the File menu. 
 
4.) Make sure that the settings within the print dialog box are correct. 
 
5.) Select either to print all of the items or just the selected ones. 
 
6.) Click “Print” to start printing or “Cancel” to abort. 

 
 
• To export the contents of the search result window/label list to a text file: 
 

1.) To export only certain items, select those items. 
 
2.) Select “Export as TEXT…” from the File Menu. 
 
3.) Choose a name and location for the file. 
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4.) Choose whether to export all of the items or just the selected ones. 
 
5.) Click “Save” to save the text file or “Cancel” to abort. 

 
 

NOTE - Exported text files will use the formatting settings (including delimiting 
characters and file creators) that were set in the “General Preferences…” 
dialog box for exporting catalog files (see chapter three). 
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CHAPTER SIX: Labeling disks 
 
DiskTracker has a built in disk labeling system that allows fully customizable, high quality disk 
labels to be printed.  Any number of disks can be selected to be labeled, each with a different 
label template, if desired.  The labeling system even knows which disks have never been labeled 
or need to be relabeled.  The built in MacDraw style label template editor (described in chapter 
seven) makes designing custom labels a snap. 
 
There are several steps to printing labels, each of which are covered in depth below: 
 

• For each disk, choose a label template to use.  When the disk is scanned, the 
default label template is assigned to every disk. 

 
• Add the disks to the disks to be labeled list.  There are automatic methods of 

doing this, if so desired. 
 
• Select a label sheet layout.  Label sheet layouts contain the dimensions and 

formatting of the sheet that the labels will be printed on. 
 
• Choose the label on the sheet where printing should start. 
 
• Preview the labels to make sure that everything looks okay. 
 
• Print and affix labels to disks. 

 
 
 
 
Choosing a label template 
Each disk can be assigned its own label template, so each disk can have a unique appearance. 
 
• Assigning a label template to disks: 
 

1.) Select the disks in the catalog window to be assigned templates. 
 
2.) Choose a label template from the “Assign Label Template” submenu within 

the Label menu.  When a disk is first scanned, the default label template is 
assigned to the disk (more on the default label template below). 

 
 
 
 
Choosing how many copies to print of a label 
It is possible to print more than one copy of a given disk label.  This is useful for situations 
where several identical labels need to be printed for identical disks.  Scan one of the disks once 
and have DiskTracker print out however many copies of the label are needed. 
 
Disks that will have multiple label copies printed will show a multiplier (e.g., “(x4)”) attached to 
the end of the name of disk label template being used to print the label. 
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• Printing multiple copies of a label: 
 

1.) Select the disk or disks in the catalog window for which multiple label copies 
are to be printed. 

 
2.) Select “Number of Label Copies…” from the Label menu. 
 
3.) Enter the number of copies to be printed for the each of the disks. 
 
4.) Click “OK” to commit the new value or “Cancel” to abort. 

 
 
 
 
Assigning disks to be labeled 
DiskTracker maintains, for each catalog file, a list of disks to be labeled.  Each of the disks on 
this list has a label produced for it when the “Print Labels” command is issued.   
 
• Adding a disk (or several disks) to the label list: 
 

1.) Select the disk or disks in the catalog window to be added to the label list. 
 
2.) Select “Add to Label List” from the Label menu. 

 
 
 
 
Removing disks from the label list 
To remove a disk from the label list, utilize the disks to be labeled window (described in depth in 
Chapter 5). 
 
• Removing disks from the to be labeled list: 
 

1.) Select “Show Label List” from the Label menu. 
 
2.) Select the disks to remove from the list. 
 
3.) Select “Remove from Label List” from the Label menu. 

 
 
 
 
Finding disks which need to be labeled 
DiskTracker can automatically find disks which need to be labeled, either because they have 
obsolete labels or because they have never been labeled. 
 
 
• Selecting disks which have never been labeled: 
 

1.) Choose “Select Unlabeled Disks” from the Label menu.  Use “Add to 
Label List” to mark these disks to be labeled. 
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• Selecting disks with obsolete labels: 
 

1.) Choose “Select Obsolete Labels” from the Label menu.  You can then use 
“Add to Label List” to mark these disks to be labeled. 

 
 
 
 
Selecting a label sheet layout 
Label sheet layouts contain information about the sheet of labels that printing will occur on.  
They contain such information as the size of the page, number of labels on the page, margins, 
and spacing.   
 
• Selecting a label sheet layout to print onto:  
 

1.) Select the desired layout from the “Use Label Sheet Layout” submenu of 
the Label menu.  The default label sheet layout (set through the “Defaults 
Preferences” dialog box) is set as the current label sheet layout each time 
DiskTracker is run. 

 
 
 
 
Creating and editing label sheet layouts 
It is possible to edit a label sheet layout so that it more accurately represents the sheet being 
printed on.  And, if special disk labels are being printed onto, it will become necessary to create 
a label sheet layout for the sheet. 
 
 
• Creating a new label sheet layout: 
 

1.) Select “New…” from the “Use Label Sheet Layout” submenu of the Label 
menu. 

 
2.) Enter a name for the new label sheet layout and click “OK” to save or 

“Cancel” to abort. 
 
3.) The label sheet layout dialog box (described below) will be presented.  Click 

“OK” after editing to save the new layout or “Cancel” to abort. 
 
 
• Editing a label sheet layout: 
 

1.) Select the label sheet layout to be edited in the “Use Label Sheet Layout” 
submenu of the Label menu. 

 
2.) Select “Edit  Label Sheet Layout…” from the Label menu. 
 
3.) The label sheet layout editor dialog (described below) will be presented.  Click 

“OK” after editing to save the new settings or “Cancel” to abort. 
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• Deleting a label sheet layout: 
 

1.) In the Finder, find the DiskTracker folder and open the “Label Sheet 
Layouts” folder within it.  Drag the appropriate layout to the trash. 

 
 
 
 
The label sheet editor 
The label sheet editor is used to set the dimensions of a label sheet.  Page dimensions are 
entered into the fields, each of which is identified by a letter. 
 
The page dimensions include: number of labels horizontally and vertically, left, right, top, and 
bottom margins, horizontal and vertical spacing between labels, and the label size. 
 
These measurements can be edited in either inches or centimeters, as set by the radio buttons 
in the dialog.  On the right side of the dialog is a diagram that shows each dimension, identified 
by its letter. 
 
 
 
 
Choosing which label to start printing on 
To conserve sheets of disk labels (which are quite expensive), DiskTracker allows printing to 
start on any label on the label sheet. 
 
• Choosing the label to start printing on: 
 

1.) Select “Start Printing From…” from the Label menu.  The Start Printing 
From dialog box will appear. 

 
2.) Click on the label position to start from. 
 
3.) Click “OK” to commit the new setting or “Cancel” to abort. 

 
 
 
 
Tweaking printing position 
Many printers have different (and often erroneous) concepts of where the edges of a sheet of 
paper is.  As a result, it is often necessary to “tweak” the overall page position to get it to line 
up with the actual edge of the labels.  DiskTracker allows both vertical and horizontal offset 
dimensions to be specified.  These dimensions will always be added to the top and left margins 
of a label sheet printout. 
 
• Setting up offset values: 
 

1.) Choose “Tweak Printing Position…” from the Label menu.  The “Tweak 
Printing Position” dialog box will be presented. 

 
2.) Enter the amount by which all of the labels should be moved up or down 

(decrease or increase the top margin, respectively) and moved to the left or 
right (decrease or increase the left margin).  These values will be stored in the 
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DiskTracker preferences file and apply to all catalog files and label sheet 
layouts. 

 
 
 
 
Previewing labels 
It is wise to preview the labels before printing them, just to make sure that the labels printed 
are the labels expected. 
 
• Previewing disk labels: 
 

1.) Choose “Prev iew Labels…” from the Label menu.  The label preview window 
has a scroll bar across the bottom to switch between which label to preview.  
The page indicator on the right side of the window shows the position on the 
page of the label being previewed. 

 
 
 
 
Printing labels 
Once everything is set correctly, it is time to print the labels. 
 
• Printing a set of labels: 
 

1.) Ensure that the Page Setup options are set correctly (choose “Page 
Setup…” from the File menu). 

 
2.) Select “Print Labels…” from the Label menu. 
 
3.) Select the number of copies, the print range, the print quality, etc., from the 

print dialog box. 
 
4.) Make sure that the label sheets are loaded into the printer. 
 
5.) Choose “Print” to start printing or “Cancel” to abort. 
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CHAPTER SEVEN: The label template editor 
 
DiskTracker provides a powerful editing environment for creating label templates.  This 
environment, which functions much like an object-oriented draw program (such as MacDraw™), 
simplifies the creation of original, creative, and functional disk labels. 
 
 
 
 
Using the label template editor 
 
• Activating the label template editor: 
 

1.) Select “Label Template Editor…” from the Label menu. 
 
2.) The editor window and a new untitled template will be presented. 

 
 
 
 
Label filing 
 

 
 
• Opening a saved label template: 
 

1.) Select a label template to open from the “Open Label Template:” pop up 
menu within the editor window. 

 
 
• Creating a new label template: 
 

1.) Click on the “New Template” button within the editor window. 
 
 
• Saving a label template: 
 

1.) If the label template has not been saved (or it is to be saved under a different 
name), click on the “Save As…” button.  Enter a name under which to save 
the file when prompted.  If the template has been already been saved at least 
once, click the “Save” button (or press � S) to save the template. 
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NOTE - Starting with version 1.1, DiskTracker used a new label template file format 

that supports much larger templates than previous versions.  These older 
versions of DiskTracker cannot read the new template format.  However, it is 
possible to save 1.1 templates in the 1.0.x format for backwards 
compatibility.  To do this, check the “Save as 1.0.x” box in the Template Save 
As dialog box.   This check box is disabled when saving a label template that is 
larger than what DiskTracker 1.0.x can open. 

 
 
• Reverting a label template to its last saved state: 
 

1.) Click on the “Revert…” button.  Confirm the choice in the resulting alert box. 
 
 
• Deleting a label template: 
 

1.) Open the label template to be deleted (choose it from the “Open Label  
Template…” pop-up menu). 

 
2.) Click the “Delete…” button.  Confirm the choice in the resulting alert box. 

 
 
 
 
Label template dimensions 
The dimensions of a label template can be set easily through the editor.  The size of a label 
template need not be the same as the size of the label sheet layout for the disk label.  If these 
measurements differ, the template will be centered within and clipped to the size of the label 
sheet label.  It is also possible to switch on a border which prints around the template to help if 
the label needs to be cut out. 
 
• Editing the size of label template: 
 

1.) Click the “Template Dimensions…” button within the editor. 
 
2.) In the dialog which appears, set the horizontal size and the front, back, and 

edge sizes of the disk label.  These sizes can be shown and edited in either 
inches or centimeters, depending on the setting  of the dialog’s radio buttons.  

 
3.) To print a border around the label (to aid in cutting out the label), check the 

“Show borders in pr intout” check box. 
 
4.) Click “OK” to commit the new settings or “Cancel” to abort. 

 
 
 
 
Drawing label templates 
The label template editor offers several tools with which to draw label templates: 
 

 
The arrow - Use to select items in the label template 
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The information field tool - Use to incorporate fields in the template which 

change from disk to disk to reflect the characteristics of the disk (including 
such things as name, size, serial number, etc.). 

 

 
The text tool - Use to create simple text fields that do not change from disk to 

disk (also called static text fields). 
 

 
The line tool - Use to draw straight lines. 
 

 
45° line tool - Use to draw lines which are constrained to angles of 45° only. 
 

 
Rectangle tool - Use to draw rectangles and boxes. 
 

 
Rounded-edge rectangle tool - Use to draw rectangles with rounded corners. 
 

 
Oval tool - Use to draw ovals and circles. 
 

 
Line widths - Use to choose the width of the lines used by the above tools.  

Choose line widths from 1 to 8 pixels . 
 

 
Foreground/background color selectors - Use to choose colors from the 

system’s color picker for the foreground (represented by the black pixels in 
the patterns) and the background (represented by the white pixels in the 
patterns) 
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Line pattern indicator - Shows the current pattern and colors used for drawing 
lines and edges of shapes.  If an upward-pointing triangle is visible below this 
box, all changes to the colors and patterns will alter the line patterns. 

 

 
Area pattern indicator - Shows the current pattern and colors used for drawing 

the inner areas of shapes.  If an upward-pointing triangle is visible below this 
box, all changes to the colors and patterns will alter the area patterns. 

 

 
Pattern selector - Choose from this palette for the line and area patterns.  An ‘N’ 

represents a transparent pattern. 
 
 
 
 
Drawing items 
To draw an item within the template editor, be sure that the correct tool is selected on the left 
side of the window.  Click the mouse at one corner of the shape. drag across and release at the 
opposite corner.  For lines, click at one end of the line, drag across and release at the other end 
of the line.  Shapes will be drawn with the default line and pattern settings (the settings that are 
visible when nothing is selected).  Text will be drawn using the area color (line color and 
area/line patterns will be ignored). 
 
 
 
 
Selecting items 
To select an item (to change its attributes or to delete it), make sure that the arrow tool is 
selected from the tool palette.  Click on  a visible portion of the item (i.e., not on a part of the 
shape that is using a transparent pattern).  If you hold down the shift key while you click on the 
item, you can select without clearing the previous selections.  In addition, you can also click on 
an unoccupied area of the editing area and drag over the items you wish to select.  You can 
select all of the items by selecting “Select Al l…” from the Edit menu, or press � A. 
 
 
 
 
Resizing items 
 
• Resizing an item: 
 

1.) Select the item to be resized. 
 
2.) Drag the resize handles (the little black squares on the corners of the item) 

until the item is the correct size. 
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Moving items 
 
• Moving items: 
 

1.) Click the items to be moved, as if selecting them.  However, don’t let go of 
the mouse button and then drag the items to their new location. 

 
 
• Moving items using the keyboard: 
 

1.) Select the items to be moved. 
 
2.) Press the arrow key that corresponds to the direction that items are to be 

moved.  They will be moved one pixel in that direction.  Hold down the shift 
key while pressing the arrow to move five pixels at a time. 

 
 
 
 
Changing the layer of an item 
Within a template, items can be in front of other items and behind others.  If an item is in the 
back, parts of it may not be visible, as they may be obscured by other items.  It is possible to 
move items forward and backward through the layers. 
 
• Changing an item’s layer: 
 

1.) Select the item whose layer is to be changed. 
 
2.) Select “Move To Back”, “Move Back One Item”, “Move Forward One 

Item”, or “Move To Front” from the arrangement menu, represented by this 
icon: 

 

 
 
 
 
 
Deleting items 
 
• Deleting an item: 
 

1.) Select the items to be deleted. 
 
2.) Select “Clear” from the Edit menu or press the delete key on the keyboard. 
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Copying and pasting items 
DiskTracker allows the pasting of PICT graphics into disk labels.  This allows you to incorporate 
color bitmapped graphics into your disk labels. 
 
• Pasting a PICT graphic into DiskTracker: 
 

1.) Copy the graphic to be pasted to the clipboard from a paint program or the 
scrapbook or other graphic source. 

 
2.) Select “Paste” from the Edit menu (or press � V). 
 
3.) The graphic will appear at the middle of the editing area.  If the graphic is 

larger than the editing area, it will be reduced in size until it fits.  Resize the 
graphic as necessary and place it in its final location. 

 
 
Items from the label template editor can also be copied as PICT graphics. 
 
• Cutting or copying items from DiskTracker: 
 

1.) Select the items to be copied. 
 
2.) Select “Copy” (� C) or “Cut” (� X) from the Edit menu. 
 
3.) The object can then be pasted back into DiskTracker as a label template item, 

or into another program as a PICT graphic. 
 
 
 
 
Editing text items 
To enter text into a static text field (that is, one that does not change from disk to disk), use 
the text entry box. 
 
• Using the text entry box: 
 

1.) Double click on the static text item to be changed. 
 
2.) Enter (or edit) the text in the Field Text dialog box. 
 
3.) Click “OK” to change the text or “Cancel” to abort. 

 
 
The font, size, style, and alignment of the text may also be altered.  Text may be rotated in 90° 
increments. 
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• Altering the text style of items: 
 

1.) Select the items. 
 
2.) Select the new text font, size, style, alignment, or rotation from the font style 

pop up menu: 
 

 
 
 
 
 
Item information fields 
Item information fields are where the real business of label templates take place.  These fields, 
which vary from disk to disk, can contain such information as the disk’s name, size, serial 
number, creation dates, and so forth.  A file list field is a special information field that can 
produce a list of the items on the disk. 
 
• Creating an item information field (this does not apply to file lists): 
 

1.) Select the kind of information field to be created from the information fields 
pop up menu. 

 
2.) Select the field tool. 
 
3.) Draw the item. 
 
4.) DiskTracker will present a dialog box to enter some text to precede the field 

with.  Typically, this would be something like “Name: ” to indicate that the 
information following is the disk’s name, for instance. 

 
5.) Click “OK” to create the field or “Cancel” to abort. 

 
 
• Creating a file list: 
 

1.) Select the “File List” item from the item field pop-up menu. 
 
2.) Select the field tool. 
 
3.) Draw the file list within the editing area. 

 
 

NOTE - File lists cannot have preceding text.  If you wish to put text preceding a 
file list, create a static text item next to the first line of the file list. 
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There are several preferences which can be adjusted for file lists, including an item filter that 
specifies which items should be included on the label.  In addition, file lists can be shown in 
either one or two columns and can have the directories underlined: 
 

 
 
 

NOTE - If a disk label template has more than one file list, all of the lists will have 
the same settings.  Each file list does not maintain its own set of file list 
preferences. 

 
 
• Setting the file list preferences: 
 

1.) Select a file list. 
 
2.) Click the “File List  Preferences…” button. 
 
3.) Adjust the settings as necessary.  The “Select Item Filter…” button 

presents the standard item filter edit dialog, as described in chapter four. 
 
4.) Click “OK” to commit the new preferences or “Cancel” to abort. 
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CHAPTER EIGHT: Exporting the contents of catalog 
files 
 
DiskTracker can easily export the contents of a catalog file to a text file. 
 
The application offers several choices for exporting data: 
 

• Export to a Text File, with or without the column headers 
 - export visible items 
 - export all items 
 - export selected items 
 
• Export selected items to the clipboard with or without the column headers 

 
 
 
 
Exporting to a text file 
 
• Exporting to a text file: 
 

1.) Select “Export as TEXT…” from the File menu. 
 
2.) Move to the folder where the text file is to be saved and give the file a name. 
 
3.) Select whether only visible items, all items, or only selected items are to be 

included in the text file. 
 
4.) To include the titles of the data columns (the column headers), make sure the 

“Include column headers” box is checked. 
 
5.) The have the names of the files indented according to how “deep” the file is, 

be sure that the “Indent files according to depth” box is checked. 
 
6.) Click “Save” to save the document or “Cancel” to abort. 

 
 
 
 
Exporting to the clipboard 
 
• Exporting to the clipboard: 
 

1.) Select the items to be copied in the catalog window. 
 
2a.) To copy without the column titles, select “Copy” from the Edit menu (or 

“Copy Disk” if only disks are selected) or press � C. 
 
2b.) To copy with the column titles, select “Copy” from the Edit menu (or “Copy 

Disk” if only disks are selected), while holding down the shift key.  
Alternatively, press shift-� C. 
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NOTE - The fields copied to the clipboard will be delimited by either tabs or 
commas, as determined by the setting in the “Preferences…” dialog box.  (see 
above) 
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CHAPTER NINE: The DiskTracker Extension 
 (Classic Mac OS only) 
 
The DiskTracker Extension, once installed and activated, will automatically scan or update disks 
as they are ejected or unmounted.  All of this can occur even when DiskTracker is not running.  
When the system is shutdown, DiskTracker will scan all of the disks connected to the computer 
as they are unmounted. 
 
To configure the DiskTracker extension, perform these steps: 
 

• Set up a catalog file into which unknown disks are to be scanned 
 
• Set up a list of catalog files containing disks which are to be updated 
 
• Set a volume filter (similar to an item filter) to specify which disks are to be 

scanned or updated. 
 
• Set a key or series of keys to override the DiskTracker Extension 

 
Each of these steps is optional, and each is described in more detail below. 
 
 
 
 
Configuring the DiskTracker Extension 
All of the configuration for the DiskTracker Extension is done through the “DiskTracker 
Extension Preferences” dialog box, accessed by selecting “DiskTracker Extension…” from 
the “Preferences” submenu of the Edit menu. 
 
 
• Enabling the DiskTracker Extension 
 

1.) Click the “Enable DiskTracker Extension auto-scanner” in the 
“DiskTracker Extension Preferences…” dialog box. 

 
 
When the DiskTracker Extension encounters a new, uncataloged disk, it can optionally scan it 
into a user-specified catalog file.  If the disk is already contained in this catalog file, it will not be 
scanned again. 
 
• Setting the catalog file into which new catalogs are scanned: 
 

1a.) If it is not already set, click the “Scan new volumes into the catalog 
file:” checkbox in the “DiskTracker Extension Preferences” dialog box.  
Select the file to scan new disk catalogs into. 

 
1b.) If the “Scan new volumes into the catalog file:” checkbox is already 

checked, click the “Set…” button next to the name of the currently selected 
catalog file.  Select the file to scan new disk catalogs into. 
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When a volume is ejected and the DiskTracker Extension auto-scanner has disk updating 
enabled, a “chain” of catalog files will be searched for a catalog of the volume being ejected.  
Only the first occurrence of the catalog for the volume will be updated, however.  That is, if a 
catalog for the volume is found in several files within the “chain” of files, only first-found catalog 
will be updated. 
 
• Enabling the DiskTracker Extension disk updater: 
 

1.) Click the “Update volumes contained in the catalog fi le(s):” checkbox. 
 
2.) If there are no catalog files listed in the list below, a dialog box will appear to 

select a catalog file to add to the list. 
 
 
• Adding a catalog file to the chain of files to be searched: 
 

1.) Click the “Add…” button next to the list of catalog files to be searched. 
 
2.) Select a catalog file to add in the resulting dialog box. 

 
 
• Removing a catalog file from the chain of files to be searched: 
 

1.) Select the catalog to be removed in the list of catalog files to be searched. 
 
2.) Click the “Remove” button next to the list. 

 
 
• Editing a entry in the chain of files to be searched list: 
 

1.) Select the entry to be edited in the list of catalog files to be searched. 
 
2.) Click the “Edit…” button next to the list. 
 
3.) Select a catalog file in the resulting dialog box. 
 
4.) The file specified by the selected entry will change to the one picked. 

 
 
Increasing the priority of a catalog file in the chain of catalog files to be searched will result in 
that catalog file being searched for disk catalogs to update earlier.  Conversely, decreasing the 
priority of a catalog file in the chain of files to be searched will result in that file being searched 
later. 
 
• Increasing the priority of a catalog file in the chain of files to be searched list: 
 

1.) Select the catalog file which is to have its search priority increased. 
 
2.) Click the “Higher Priority” button located under the list. 

 
 
• Decreasing the priority of a catalog file in the chain of files to be searched list: 
 

1.) Select the catalog file which is to have its search priority decreased. 
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2.) Click the “Lower Priority” button located under the list. 

 
 
A volume filter (very similar to an item filter) can be set to specify which volumes the 
DiskTracker Extension should examine when they are ejected or unmounted.  This volume filter 
can, for instance, filter out slow-scanning volumes such as CD-ROMs and file servers, or can 
eliminate constantly changing disks like RAM disks from the catalog files. 
 
• Setting or editing the DiskTracker Extension volume filter: 
 

1.) If it is not checked, set the “Scan/Update only volumes which match 
the f ilter:” checkbox. 

 
2a.) If no item filter is specified, the edit volume filter dialog box will be presented 

after clicking the checkbox.  This dialog box works just like the edit item filter 
dialog box, described in chapter four. 

 
2b.) If an item filter is already specified, click the “Edit…” button.  The edit 

volume filter dialog box will be presented.  This dialog box works just like the 
edit item filter dialog box, described in chapter four. 

 
 
The DiskTracker Extension can be configured to ignore all disks being ejected if a combination of 
modifiers is held down as disks are ejected or unmounted.  This is convenient when restarting, 
when the DiskTracker Extension might make the shutdown process too long as it scans each 
disk as it is unmounted. 
 
• Setting which modifier keys disable the DiskTracker Extension: 
 

1.) Check the “Don’t  scan/update when these keys are down:” checkbox. 
 
2.) Click the checkboxes next to the modifiers to hold down to disable the auto-

scanner. 


